Table of Contents

What is GeneLab? .................................................................................................................... 3

An Overview of the User Interface .......................................................................................... 3
  GeneLab Home Page ........................................................................................................... 3
  GeneLab Data System Menu Selection .............................................................................. 5

Search Utility in GeneLab Data System .............................................................................. 6
  Search Bar ......................................................................................................................... 6
  Search Filters ...................................................................................................................... 9
  Data Integration / Federation for Search Bar ..................................................................... 11

GeneLab Data Repository ................................................................................................... 12
  Metadata User Interface ................................................................................................... 13

Environmental Data ......................................................................................................... 16

Data Visualization of the GeneLab Data System ................................................................. 18

Tools ................................................................................................................................... 19
  Setting up a User Account ............................................................................................... 19

Analysis Platform .............................................................................................................. 26

Collaborative Workspace ................................................................................................. 27
  Workspace User Interface ............................................................................................... 29
  Manage folders and files ................................................................................................. 30
  Upload files and manage storage .................................................................................... 32
  Copy/Move folders and files .......................................................................................... 34
  Share data and manage groups ...................................................................................... 35
  Launch tools ................................................................................................................... 38

Integrated Search and Federation APIs ............................................................................ 38
What is GeneLab?

The GeneLab project is both a science collaboration initiative as well as a data system that provides a collaborative workspace with tools to analyze and visualize space relevant omics data. Our primary goal is to maximize the utilization of the valuable biological research conducted aboard the International Space Station (ISS) by collecting genomic, transcriptomic, proteomic, and metabolomics data known as “omics”. One important aspect of GeneLab’s primary goal is to help the scientific community and the population at large gain new knowledge from space omics data. By providing a portal linking processed data to flight parameters, GeneLab enables exploration of the molecular network responses of terrestrial biology to the space environment. This allows researchers to understand the complex responses of biological systems to the space environment. GeneLab data will be useful for the development of countermeasures, monitoring the microbes that colonize the space station, understanding how plants (food) could be modified to grow better in space, and unraveling the responses of humans and other organisms to the combined effects of altered gravity and space radiation.

An Overview of the User Interface

GeneLab Home Page

https://genelab.nasa.gov/
 Navigation menu – click on any of the options to navigate through the different pages

**Home:** GeneLab home page includes the navigation menu, Latest data releases, Latest news, Spotlight features, Research opportunities and recent publications.

**About:** Click on the about page to learn more about the GeneLab project, International Space Station, space biology experiments, GeneLab’s Analysis Working Groups, our sponsors, and archived newsletters.

**Data & Tools:** Links to all the available data and tools, including the Data Repository, Environmental Data, Analysis Platform, and Collaborative Workspace.

**Research & Resources:** Links to publications, internship resources and other related NASA resources.

**Help:** Links to all the featured tutorials, Frequently Asked Questions (FAQs), and GeneLab contact information.

GeneLab Data Systems buttons

Click on the featured buttons to navigate through the different pages and tools. These links will direct you to the Data Repository, Analysis Platform, Environmental Data, Collaborative Workspace, data submission webpage, and tutorials.

*Explore the GeneLab home page by scrolling down to find more information about the latest data releases, news, and events.*
GeneLab Data System Menu Selection

https://genelab-data.ndc.nasa.gov/genelab/

GeneLab Data System landing page – includes links to the Data Repository and Workspace

① GLDS Navigation menu – click on any of the options to navigate through the different pages

Home: Click here to navigate to the GeneLab Home page https://genelab.nasa.gov/

GLDS: Landing page for the GLDS, provides information about the GeneLab repository, study metadata, and GeneLab project sponsors.

Data Repository: Contains all the curated and published studies in the GeneLab repository.

Environmental Data: This page includes information about and data from the spacecraft or payload environment.

Tools: Drop down menu to navigate to the available tools. Current tools include the Analysis Platform (Analyze Data) and Collaborative Workspace.

Submit Data: Provides information on how to submit data to GeneLab.
**Tutorials:** Links to various tutorials and manuals to help navigate through and access the GeneLab Data System and website.

**Help:** Links to Frequently Asked Questions (FAQs) and GeneLab contact information.

② Search Bar – provides the ability to perform searches across several omics databases, including GeneLab, NIH GEO, EBI PRIDE, and/or ANL MG-RAST.

③ Search Filters – provides the ability to search the GeneLab repository using filters such as ground vs. spaceflight studies, study factors, study organisms, and study assay type.

④ Data Visualization Dashboard – provides a visual representation of all the datasets housed in the GeneLab repository

**Search Utility in GeneLab Data System**

**Search Bar**

**GeneLab Data System** provides users a full-text search capability of the metadata for all datasets. Full-text search terms can be a single word or multiple words with either Boolean, wildcards (asterisks *), and/or string (text) literals. Note that the searches are case-insensitive with respect to search term(s). To perform a search, enter a keyword or set of keywords, in the search box and either press ‘Enter’ or use your mouse to select the magnifying glass icon.

Search results can be sorted by **relevance, release date, source, and title** with either ascending or descending orders. In addition, to see an overview of the study metadata, click on the "◆" arrow, (near the right margin, circled in red above) to show highlighted keyword search relevance.

Click on a **title** to show the detailed metadata for that study. Use the page navigator on the top right corner to go the next page of search results. Below are some examples of searches.
Single term search:

Example: Search results from searching the single term ‘genome’

An example of a multiple term search is shown below. All search terms will be found in each of the search results.

Example: Search results from searching on multiple terms ‘genome sequencing’

If multiple words are in double quotations then those words must match exactly in the order given, as shown below:
Search results from searching the exact term “genome sequencing” by using quotation marks

Boolean operators (see table below) can be included with the search terms.

**Boolean Operators**

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AND</td>
<td>ALL search terms must be present (default Boolean search)</td>
</tr>
<tr>
<td>OR</td>
<td>ANY of your search terms can be present</td>
</tr>
<tr>
<td>NOT</td>
<td>Exclude words from your search</td>
</tr>
</tbody>
</table>

Below is a search using the ‘AND’ operator. Note that the resulting set is the same as searching for the terms ‘genome’ and ‘sequencing’ without the operator.
**Search results from using ‘AND’ operator to search on both terms ‘genome’ and ‘sequencing’**

Please note that you may not use both the Boolean operators and double quotations together.

No search results due to using incorrect techniques

**Other search techniques:**

- Exclude studies containing term(s) from your search using the minus prefix (-)
  
  Example: genome sequencing –mouse

- Require term(s) in your search using the plus prefix (+)

  Example: genome sequencing +bacillus

- Search on unspecified portions of search terms using an asterisk (*)

  Example: geno* sequencing

In addition to searching the GeneLab Data Repository, federated data repositories can be included in the search as well. See below for more information on the federated data repositories.

**Search Filters**

GeneLab also provides some filters to assist in searching the GeneLab repository. The filters include: Project Type, Factors, Organisms, and Assay Types. The menus for each category are pre-populated with terms from datasets included in the GeneLab repository.

Note that you can use the filters *without* using any additional search terms.

Currently the search filters only work on filtering data housed in the GeneLab data repository.

Selecting a filter box opens up a list of choices for that filter. Each time a filter is selected, the filter is immediately applied, possibly changing the number of search results shown. As the filter values are added, they are displayed as text above the results. The user can select multiple
options from the same filter type. For example, filter your search by selecting ‘microgravity’ and then ‘age’ from the Factors menu. GeneLab searches for those studies that have either ‘microgravity’ OR ‘age’ factors.

Filter Search by selecting ‘Age’ and ‘Microgravity’ under Factors

Multiple types of filters may be applied to a query to find studies that have values from all of the selected filter types. For example, when applying the factor type filter options ‘age’ and ‘microgravity’ the results contain one or both of these terms. Adding a different type of filter, such as organism ‘microbiota’, will include only data sets containing ‘microbiota’ organisms AND whose factors include ‘age’ or ‘microgravity’.

Filter Search by selecting ‘Age’ or ‘Microgravity’ under Factors AND ‘Microbiota’ under Organism
Users can change selected filter terms by either selecting the filter again from the drop-down menu or by selecting the ‘Clear’ button. Each selected filter is applied until it is de-selected or all filters are cleared. Note that the ‘Clear’ button only clears the filter terms, and does not remove text search term(s) entered above the filters.

Data Integration / Federation for Search Bar

GeneLab has integrated, commonly termed as data federation, with multiple heterogeneous external databases. Users can search across multiple databases in addition to GeneLab. The links in the federated search results are to the authoritative external databases.

GeneLab is currently federated with:

- The National Institutes of Health (NIH) Gene Expression Omnibus (GEO)
- The European Bioinformatics Institute (EBI) Proteomics Identification (PRIDE)
- The Argonne National Laboratory (ANL) Metagenomics Rapid Annotations using Subsystems Technology (MG-RAST)

The GeneLab repository does not contain copies of the data sets found in the external databases but, instead GeneLab maintains metadata records (e.g., information about the data) of the external data sets. These records are automatically updated on a nightly basis to keep the GeneLab database search content up-to-date with the external databases.

As noted earlier, currently the search filters only work with the GeneLab database. The mapping of the filters between GeneLab and the external databases is ongoing and will be included in a future release of GeneLab.

To search in one or all of these databases, enter text search term(s) and select the desired databases as shown below. To execute the search, press Enter or click the magnifying glass icon. Federated search results are then shown. You may change the database selection(s) at any time and the search results will be updated accordingly.
Data federation example, searching across multiple data repositories

**GeneLab Data Repository**

[https://genelab-data.ndc.nasa.gov/genelab/projects/](https://genelab-data.ndc.nasa.gov/genelab/projects/)

Another way to access GeneLab data is to select “Data Repository” in the menu bar. You can then browse the data repository by using the various search techniques discussed above or navigate through the list by scrolling. To select a study, click on the study icon or title, which will direct you to that study’s metadata and data files. An example is shown below.
Study metadata are viewable through a tabbed user interface for each study (see below). Click on each tab to navigate through the different sections: Description, Protocols, Sample and Assay Tables, Publications and Study Files.

The **Description** tab provides an overview of the study including a text description, contact information, experimental factors, organism(s), type of assay(s), project and/or mission details, and funding information.
Example of the Description view for GeneLab dataset, GLDS-138.

The **Protocols** tab provides the names and detailed descriptions of the sample collection, treatment, assay, data processing, and any other study protocol(s).

The **Samples and Assays** tabs provides sample and assay level details formatted in a navigatable table. Information found in these tabs include specific organism characteristics, study factors and treatments, sample and sample processing metadata, assay execution parameters, and data processing metadata. Use the bottom navigation bar to scroll through all the columns, and the right margin scroll bar to navigate the rows.

### Filtering

Click the ⬇️ button to sort or filter the values in one or more columns. Use **Sort Ascending** or **Sort Descending** to sort the values in the column. Click on **Columns** to hide (uncheck) or show (check) columns within that table; by default all columns are shown. To filter values for one or more columns, use the options under **Filter** and enter the desired value(s) or value ranges. See example below.
Example of a GeneLab dataset, GLDS-138, sample table tab and sort/filter functions.

**Exporting tables to csv**

Users can download selected columns from the Samples and/or Assays table. Click on the **Select Export Columns** button. Select the desired columns and click **Export CSV**.
The **Publications** tab contains metadata for relevant publication(s) including title, authors and link(s).

The **Study Files** tab provides metadata regarding raw and/or processed study data files. Each row includes information about the size, type, and description of the file set. Click on the file name to download.

Use the \[ \] button to sort or to filter the values in one or more columns.

---

**Environmental Data**

GeneLab has incorporated additional data to support spaceflight experiments. These data include environmental data from the spacecraft or payloads (hardware). Currently, GeneLab has gathered radiation dosimetry data from spaceflight experiments and provides a complete table for Space Transportation Shuttle (STS) missions under the 'Environmental Data' menu option. The table is shown below.
In addition, users can find radiation dosimetry details per sample within the sample table for available STS mission experiments. To access this data, click on the desired GLDS number on the table and navigate to the Samples tab.
Data Visualization of the GeneLab Data System

The Data Visualization Dashboard provides a visual display of GeneLab datasets organized by Organism(s) and Assay type(s). All the nodes, organisms, GLDS Numbers and Assay Types, are clickable. Once clicked, the links corresponding to that node become highlighted (clicking on the same node again will remove the highlight). The nodes can also each be moved vertically.

Clicking on an organism will highlight the paths from that Organism to all the associated studies and their assay types.

Organism 'Pseudomonas aeruginosa' node was selected highlighting the links to GLDS-15, GLDS-14, and transcription profiling.

Click on an assay type node to highlight links to the GLDS number and Organism associated with that assay. Similarly, selecting the GLDS number node will link the corresponding organism and assay type(s).
Example of results after selecting assay type 'protein expression profiling'

**Tools**

The GeneLab Data System provides two tools: Analysis Platform and the Collaborative Workspace. The Analysis Platform provides users with bioinformatics tools to analyze spaceflight-related omics data. To upload, store, organize, and share files, users can utilize the Collaborative Workspace. To access these tools, users must create an account using a Google login or NASA credentials.

**Setting up a User Account**

To create a NASA Analysis Platform and/or Collaborative Workspace user account, click on Tools from the top menu and select the desired tool:
1. On the login page (shown below), use the **Sign in with Google** or **NASA GeneLab Authenticate** button to login.

2. For Google login, if you don't already have an account, create an account by selecting the "here" link circled in the image below and following the steps.
3. Once you have a Google ID, select the **Sign in with Google** button and use your google account to login (example below).
Sign In
This NASA Galaxy instance has been configured such that only users who are logged in may use it. If you don't already have an account, please create a Google account here.

Important Note: If straight Google social login (e.g., using GMail username and password) has a HTTP 500 "Internal Server Error" (temporarily issue), then please click the "NASA LaunchPad Authenticate" instead and choose the "Agency User ID" option for NASA Guest User authentication after successful one-time GMail account registration process. Login using your GMail username and randomly generated password received in your GMail account.

NASA Usage Disclaimer
This is a US Government system and is for authorized users only. By accessing and using this information system, you acknowledge and consent to the following:

You are accessing a U.S. Government information system, which includes:
(1) this computer; (2) this computer network; (3) all computers connected to this network; and (4) all devices and storage media attached to this network or to a computer on this network; and (5) cloud and remote information services. This information system is provided for U.S. Government-authorized use only. You have no reasonable expectation of privacy regarding any communication transmitted through or data stored on this information system. At any time, and for any lawful purpose, the U.S. Government may monitor, intercept, search and seize any communication or data transiting, stored on, or traveling to or from this information system. You are NOT authorized to process classified information on this information system. Unauthorized or improper use of this system may result in suspension or loss of access privileges, disciplinary action, and civil and/or criminal penalties.

NASA LaunchPad Authenticate
4. A NASA Guest Account Registration page opens up. Click, **Yes Register Google Account** to continue.

5. You have now successfully registered your google account with NASA.

7. Click on the Sign in with Google button. Select the registered Google account and it will direct you to the GeneLab tool.

   Note: You only have to register your Google account once with NASA. Once registered, you can use this google account to log in to both tools.

8. If you are a NASA LaunchPad user, click on the NASA LaunchPad Authenticate button (outlined in red below).
9. You may use any of the options (Smartcard, RSA Token, or Agency User ID) to log in. Enter your information and it will direct you to the GeneLab tool.
Analysis Platform

Powered by Galaxy, the Analysis Platform provides bioinformatics tools to analyze omics data. This platform, listed as Analyze Data in the menu, has various transcriptomics tools to transform raw data into processed data. Users may use data from the GeneLab repository or upload their own data files.

1. On the GLDS menu, select Tools then Analyze Data.

2. Log in using your Google account or NASA credentials.
3. The Analysis Platform home page (https://genelab-data.ndc.nasa.gov/galaxy/) will open (see below).

4. Use the Galaxy UI interactive tour (circled below) to get familiar with this platform.
GeneLab, with guidance from the scientific community, has established pipelines to process omics data. Users can use the RNA-Seq tutorial as a guide to analyze RNA-Seq data with this platform. This tutorial can be found under Help → RNA-Seq Analysis Tutorial or https://genelab-data.ndc.nasa.gov/genelab/help/RNA-Seq_analysis_tutorial.pdf.

**Collaborative Workspace**

GeneLab provides each user with a workspace to manage files and access data analysis tools. To access the workspace, users will need to create an account. Within this framework, users can share data files and analysis results with other users and/or groups, have access to the data in the GeneLab public repository, and data analysis tools.

1. On the GLDS menu, select **Tools** then **Collaborative Workspace**

2. Log in using your Google account or NASA credentials.
3. The Collaborative Workspace home page (https://genelab-data.ndc.nasa.gov/jsui) opens and includes a **Welcome to NASA GeneLab** popup (shown below).
4. Click **Close** or the “x” at the top right of the popup to dismiss the welcome dialog box.
Workspace User Interface
https://genelab-data.ndc.nasa.gov/jsui/

The following is a description of the features of the GeneLab Workspace home page.

GeneLab Collaborative Workspace

1. **Left directories panel** – provides an overview of directories and files

   - **User private folder**: *username* folder (spaceBio in this example) contains folders and files visible only to the user

   - **Shared folder**: Shared to *username* folder contains folders and files shared from other users

   - **Public folder**: Contains datasets published in the GeneLab Repository

2. **Main files panel** – lists the files within a selected folder

3. **Navigation menu** – organizes functions for managing files and groups, launching tools, accessing user guides, and links to the GeneLab Data Repository

4. **Toolbar** – displays tools and data sources as interactive icons that, when clicked, will launch the tool

5. ‘Right-click’ pop-up menu – provides menu options to manage selected file(s) or folder

6. **Search bar** – searches folders and file names for descriptions and tags within your workspace

7. **User profile** – click here to find profile information, history, and to log out
Manage folders and files

Use the left directories panel to manage your private and shared folders and to expand the public folder. Click on the folder icon to expand or collapse the folder. You can manage your folders by clicking on the triangle icon to the right of the folder name (circled below), by right-clicking on the folder name, or by selecting the folder and using the File menu.

Upload function will prompt a pop-up informing the user to drag and drop file(s) into the workspace folder

Create Subdirectory creates a folder under the selected folder

View directory link provides a web link to the selected folder

Sharing provides options to share folder with colleagues and permission settings

Use Tags to add searchable terms to your folder

Rename option can be used to edit or update a folder name

Copy/Move function provides the ability to copy or move a folder within your directory structure

Delete will delete a folder and all of its contents

Folder menu options are also available by right-clicking on the folder in the main files panel or selecting the folder and using the File menu.
Navigate to the desired directory or subdirectory. In the **main files panel**, manage your files by right-clicking on the folder name, or by selecting the file and using the **File** menu.

File menu is similar to the folder function options stated above. Additional functions include:

- **Preview** text-based files
- **Extract rows or columns** from a tab- or comma-delimited file and save to a new file
- **Convert** a file to another file format
- **Download** the selected file(s) to your local machine
- **Expand Archive** will extract the compressed file into a specified directory *(option not shown in snapshot)*
Upload files and manage storage

To upload a file to your account, import the file by dragging-and-dropping the file from your local computer to the desired folder or import the file using the URL option (examples shown below).

Drag-and-drop your file from your desktop to the selected directory in the main file panel. Drop the file when the selected area is green.

Upload progress can be viewed by:

1. Click on the ‘up arrow’ on the top right of the page next to the profile icon. A pop-up window will provide a history of uploaded files and the status of the current upload
2. Percentage progress bar at the bottom of the browser

To import from a URL, go to File and select Import from URL. Provide a URL address, copy and paste the link, or drag and drop the URL address. Click the ‘Go’ button.
A dialog box will open in a new window (see example below), select the destination folder and edit the file name if desired. Click Submit. View percentage progress bar at the bottom of the browser to monitor the file upload status (green: upload in progress; white: upload completed; red: error during upload)

Please note, if you exceed the storage quota of **30 GB**, you will receive a pop-up message to remove some files. If your project requires more space, please contact us at glds-dev@nx.arc.nasa.gov with your specific needs and provide justification for your request.
To check how much storage you are using, click on your user account name on the top right-hand corner and select **Profile** as shown below.

Copy/Move folders and files

Copy and/or move functions are available only to directories for which you have read/write permissions.

To **Copy** files/folders, you need read permission. Once copied into a private workspace, the user can manipulate the file.

- Right-click the file name and select Copy/Move from the pop-up menu. Click Copy.
- Check the file(s)/folder(s) you want to Copy/Move and select File menu > Copy/Move. Select the destination then click Copy.

To **Move** files/folders, you need read and write permissions.

- Drag and drop the file/folder into another directory in either the main files panel or the left directories panel.
- Right-click the file name and select Copy/Move from the pop-up menu. Click Move.
- Check the file(s)/folder(s) you want to Copy/Move and select File menu > Copy/Move. Select the destination then click Move.

Users can copy folder(s)/file(s) from the public folder, which contains data in the GeneLab Data Repository, to their personal folder. An example of copying a dataset from the public folder is shown below.
1. Expand the public folder in the left directories panel
2. Select the folder/file to copy and right click and select Copy/Move from the pop-up menu
3. Select the destination and click Copy
4. View file copy progress on the bottom left corner of the browser

Once completed, the copied folder/file will be available in the selected directory.

Share data and manage groups

You may share folders and data files by inviting your collaborators to sign up for a GeneLab user account or share with other GeneLab users.

To invite your colleagues to join GeneLab, click the *Invite a collaborator* button on the top of your workspace page (circled in red below).

File and folder sharing settings can be accessed by selecting the file/folder you want to share and selecting *File > Sharing* or by right-clicking on file/folder then selecting *Sharing*.

The Sharing & Permissions dialog box (shown below) includes:

- file/folder name
- the owner
- users with which items are shared, including the owner and level of privilege
- Edit Sharing button
- Close button
Click on the Edit Sharing button to open, change, or add sharing and permission settings. The two levels of permissions are Read, which allows only copying, and Read, Write, & Delete, which allows copying, moving, and editing of the folder/files. An example is shown below.

1. Lists the file/folder name to be shared.
2. Lists the shared user or group name(s) and privileges. Click the red x to remove the current permissions.
3. To Share with User, enter the username and select the privilege level. To find a user, enter the username or email and select the magnifying glass icon.
4. To Share with Group, select a group and the privilege level. To manage groups, click on the icon. See next section below.
5. Check the box to notify users or groups of the file(s)/folder(s) to be shared. An email will be sent to those user(s).
6. To save changes, click the Grant Permissions button.
To manage groups, select *Manage* from the top navigation menu or click on the icon in the *Edit Share & Permission* dialog box (from Step 4 above). An example is shown below.

1. List of groups in which you are a member are displayed under *Group Names*. Click on the group name, to view and edit the group members.
   a. To delete a group, click *Delete Selected Group* button (admins only)
2. To create a new group, enter the Group name and description and click *Add New Group*.
3. Lists the group members in the selected group from step 1. Click on the red x to remove a member from that group.
4. To add a user to the selected group, enter the username. To find a user, click on the magnifying glass and enter the username or email; find and click Select.
   a. Check the *User can administrator group* box to make a user a group administrator.
5. Click Close. Follow steps 5 and 6 from the section above; Click Grant Permission to save changes.
Launch tools

To launch tools, select Launch in the top navigation menu or click on the tool icon. To view additional information, hover over the tool icon and click on the arrow on the right side of each icon. A menu displaying the options Launch, Help, Details, and Hide will be displayed. Select the Help option for the Tool User Guide.

Example of tools in a workspace toolshed. *This does not reflect the current tools available in GeneLab.

Integrated Search and Federation APIs

GeneLab provides a RESTful Application Programming Interface (API) to its full-text search capability, which provides the same functionality available through the GeneLab website. As mentioned previously, the search filters are only available for GeneLab data set searches. The API provides a choice of standardized web output formats, such as JavaScript Object Notation (JSON) or Hyper Text Markup Language (HTML), of the search results.

A sample basic search of the GeneLab repository returning JSON output format:
https://{HOSTNAME}/genelab/data/search?term={TERM}&type={TYPE}

For example: https://genelab-data.ndc.nasa.gov/genelab/data/search?term=DNA&type=cgene

Another example, with a more complex query: https://genelab-data.ndc.nasa.gov/genelab/data/search?term=space&from=0&type=cgene.nih.geo.gse&ffield=links&fvalue=GPL16417&ffield=Data Source Accession&fvalue=GSE82255

A sample basic search of the GeneLab repository returning HTML output format:
https://{HOSTNAME}/genelab/?q={TERM}&data_source={TYPE}

For example: https://genelab-data.ndc.nasa.gov/genelab/search_studies/?q=cancer&data_source=cgene

Another example with a more complex query: https://genelab-data.ndc.nasa.gov/genelab/search_studies/?q=space&from=0&data_source=cgene.nih.geo.gse&ffield=links&fvalue=GPL16417&ffield=Data Source Accession&fvalue=GSE82255
Data sources

<table>
<thead>
<tr>
<th>Data source</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>GeneLab</td>
<td>cgene</td>
</tr>
<tr>
<td>NIH GEO</td>
<td>nih_geo_gse</td>
</tr>
<tr>
<td>EBI PRIDE</td>
<td>ebi_pride</td>
</tr>
<tr>
<td>MG-RAST</td>
<td>mg_rast</td>
</tr>
</tbody>
</table>

Default Elastic Search engine is configured to be Boolean ‘AND’ for all keyword searches.

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Definition</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>term</td>
<td>Search keyword</td>
<td>String</td>
</tr>
<tr>
<td>from</td>
<td>Starting page</td>
<td>Integer (single value)</td>
</tr>
<tr>
<td>size</td>
<td>Search result display count</td>
<td>Integer (single value)</td>
</tr>
<tr>
<td>type</td>
<td>Data source</td>
<td>cgene, nih_geo, ebi_pride, mg_rast (accepts multiple values separated by comma)</td>
</tr>
<tr>
<td>sort</td>
<td>Sort field</td>
<td>String (Field Name)</td>
</tr>
<tr>
<td>order</td>
<td>Sort order</td>
<td>ASC - ascending order; DESC - descending order</td>
</tr>
<tr>
<td>ffield</td>
<td>Filter field</td>
<td>String (should always be paired with fvalue)</td>
</tr>
<tr>
<td>fvalue</td>
<td>Filter value</td>
<td>String (should always be paired with ffield)</td>
</tr>
</tbody>
</table>

Boolean Operators

<table>
<thead>
<tr>
<th>Operator</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>AND</td>
<td>ALL search terms must be present (default Boolean search)</td>
</tr>
<tr>
<td>OR</td>
<td>ANY of your search terms can be present</td>
</tr>
<tr>
<td>NOT</td>
<td>Exclude words from your search</td>
</tr>
</tbody>
</table>

Please review our FAQ page or send any inquires/questions to genelab-outreach@lists.nasa.gov.